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Description 
 

The UNIT DualMCU-ONE by UNIT 
Electronics is a highly versatile 
development board that combines the 
capabilities of ESP32 and RP2040 
microcontrollers. Designed for advanced 
projects, it offers enhanced connectivity, 
robust power management, and full 
compatibility with Arduino UNO shields.  
 
The DualMCU-ONE board enhances its 
predecessor DUALMCU by integrating SPI 
communication between the MCUs and 
incorporating a USB Type-C hub in place 
of the traditional USB communication 
switch. Additionally, it features direct CAN 
bus connectivity, enabling robust and 
efficient communication in automotive and 
industrial environments.  
 
 This combination of features makes the 
UNIT DualMCU-ONE an essential tool for 
developing demanding applications that 
require advanced connectivity and the 
ability to handle multiple communication 
protocols. It offers flexibility with 
programming languages such as C/C++, 
MicroPython, and CircuitPython. 
 
 
Arduino UNO format compatibility. 
 
This versatile board, formatted like the 

Arduino UNO, integrates dual 32-bit 
microcontrollers — the RP2040 operates at 
133 MHz and the ESP32 at 240 MHz — 
within a compact 53mm x 68mm PCB.  

 
 
RP2040: Is the central core connected to the 

pin headers, enabling the DualMCU-ONE to 
maintain full pin compatibility with Arduino UNO 
shields, facilitating easy upgrades to existing 
projects (see Table 4.3.1). 

 
ESP32: Provides Wi-Fi, Bluetooth, and CAN 

bus capabilities.  
 
 
The DualMCU-ONE board is fully 

supported in the Arduino development 
environment for both microcontrollers, 
ensuring seamless integration with existing 
Arduino projects and libraries. For details 
on the Arduino packages for each 
microcontroller, see Section 5.1. 
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Enhanced Communication and 
Connectivity Between MCUs 

UART & SPI: To ensure robust 
communication between the RP2040 and 
ESP32 microcontrollers, a dual-interface 
approach has been implemented: 

●​ UART interface: The primary 
connection leverages a UART link, 
where the UART0 of the RP2040 is 
connected to the UART2 of the 
ESP32. A DIP switch facilitates this 
connection by physically linking the 
TX pin of one microcontroller to the 
RX pin of the other, and vice versa, 
(see Table 3.12.1). This modular 
setup allows for easy 
reconfiguration or isolation of 
the UART connection as needed, 
enhancing flexibility during 
development and testing. 

 

●​ SPI interface: Additionally, to 
address potential limitations in data 
transfer speed and reliability 
associated with UART 
communication, a high-speed SPI 
interface has been integrated 
between the two microcontrollers. 
This SPI implementation 
significantly improves the overall 
performance of the system by 
offering faster data exchange rates 
and more robust error handling 
mechanisms. For further details, 
refer to Table 3.13.1, which 
outlines the pin mappings and 
configurations used in this setup. 

 

 

 

The combination of UART for basic 
communication and SPI for high-speed 
data transfer ensures seamless and 
reliable interaction between the RP2040 
and ESP32, enabling more complex and 
data-intensive applications. For example, 
the ESP32 can operate as a wireless 
co-processor, providing the RP2040 
microcontroller with Wi-Fi or Bluetooth 
connectivity, while concurrently managing 
CAN BUS communication. This 
configuration enables simultaneous 
processes where the ESP32 handles 
communication tasks, while the RP2040 
focuses on other operations.  

USB Hub Integration: The traditional 
USB communication switch found in the 
original (DUALMCU) has been replaced 
with a USB Type-C hub based on the 
HS8836A, enabling simultaneous 
connections to both the RP2040 and 
ESP32 microcontrollers using a single 
USB Type-C cable.  

This hub simplifies the design by 
consolidating USB communication into 
one interface, enhancing usability and 
reducing cable clutter. 

In addition to supporting the two 
microcontrollers, the hub provides 
connectivity for two additional USB 
devices through JST connectors with a 1 
mm pitch. Each JST connector includes 
pins for +VUSB, D-, D+, and GND (see 
schematic at the end of the document), 
enabling direct communication with 
peripheral devices.  
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These connectors allow users to extend 
the functionality of the system by 
connecting USB-powered devices such 
as: 

●​ Human Interface Devices (HIDs): 
A USB mouse or keyboard can be 
connected, enabling interactive 
applications like user interface 
navigation or data input. 

●​ Development Boards: Smaller 
USB-enabled boards, such as a 
DualMCU, Seeed Studio Xiao or 
Adafruit Boards, can be integrated 
into the system to perform 
additional specialized tasks. 

●​ Sensors or Modules: 
USB-enabled modules, such as a 
USB camera, temperature sensor, 
or GPS receiver, can be connected 
for advanced sensing or 
positioning capabilities. 

This setup ensures that all devices 
connected via the JST connectors are 
powered and managed through the same 
Type-C cable that links the DUALMCU to 
a host computer. The seamless integration 
provided by the HS8836A hub enhances 
the system's versatility, enabling complex 
setups without requiring additional USB 
ports or cables. 

For further details on the functionality of 
the JST connectors, refer to Section 4.7 - 
Auxiliary JST Connectors (1mm Pitch) 
for USB. Additionally, consult the 
schematic at the end of this document for 
a clear overview of the electrical 
connections and layout. 

 

 

 

 

I2C Connectors: 

Easily connect a wide range of I2C 
devices using the board’s STEMMA and 
QWIIC-compatible JST-SH I2C 
connectors. These connectors feature a 
1 mm pitch and 4 pins (+V, GND, SDA, 
and SCL), ensuring compatibility with a 
variety of sensors and modules. Each 
microcontroller has its own dedicated 
QWIIC connector for enhanced flexibility: 

●​ For the RP2040, refer to Table 
4.4.2 - RP2040 I2C-QWIIC 
Connector for pin mappings. 

●​ For the ESP32, refer to Table 4.5.3 
- ESP32 I2C-QWIIC Connector for 
detailed configurations. 

This modular setup simplifies the 
integration of peripherals, allowing 
developers to focus on project 
functionality without worrying about 
hardware compatibility. 

Dynamic Visual Feedback: 

To enhance interactivity and improve user 
experience, the board includes onboard 
RGB 2020, WS2812B, and 0603 LEDs. 
These LEDs provide versatile visual 
feedback, ideal for a range of applications: 

●​ Status Indications: Real-time 
feedback on system states, such 
as power, connectivity, or 
processing activity. 

●​ Visual Alerts: Notifications for 
specific events or errors during 
operation. 

●​ User Interaction: Dynamic visual 
effects to make projects more 
engaging and intuitive. 
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The onboard LEDs include: 

●​ L1 - Power On LED: Indicates that 
the board is powered on, ensuring 
the system is receiving power. 

●​ L2 - Built-in LED: Typically used 
for basic operation feedback, such 
as indicating a boot process or 
active state of the board. 

●​ L3 - TX LED: Lights up when data 
is being transmitted, providing 
visual feedback of UART 
communication from the ESP32 
microcontroller. 

●​ L4 - RX LED: Lights up when data 
is being received, providing visual 
feedback of UART communication 
to the ESP32 microcontroller. 

●​ L5 - RGB-2020 LED: Used for 
more dynamic and customizable 
feedback, capable of displaying 
multiple colors for status alerts or 
visual effects. 

●​ L6 - WS2812B-3030 LED: A 
high-performance LED used for 
complex lighting effects, offering 
full RGB control and the ability to 
create colorful patterns or 
animations. 

These LEDs are discussed in more detail 
in the following sections: 

●​ Section 3.2 - Board Topology 
●​ Section 3.7 - RGB LED  
●​ Section 3.8 - WS2812B LED 

 

 

 

 

 

Micro SD: 

The DualMCU-ONE board includes a 
Micro SD socket (X1, refer to Table 3.2.2) 
among its available connectors, 
supporting high-capacity memories up to 
64 GB (tested). This socket is directly 
connected to the ESP32 microcontroller 
via QSPI communication, offering data 
transfer speeds up to four times faster 
than its predecessor, the DualMCU. This 
improvement provides more efficient data 
handling, making it ideal for projects 
requiring large storage and rapid data 
access. 

The Micro SD socket, model 
THD2528-11SD-GF, can be soldered 
directly onto the bottom side of the board. 
Please note that this socket is not 
pre-installed on the DualMCU-ONE board. 
However, end users can purchase the 
socket separately and solder it onto the 
designated pads, offering flexibility for 
those who wish to utilize this feature. 

FPC-24P connector for ESP32 MCU 

With a 24-pin FPC connector like the 
AFC01-S24FCC or AFC07-S24ECC (X2 
on the PCB; see Table 3.2.2 - Rear View), 
available separately, the board’s 
connectivity can be greatly expanded. 
This connector can be soldered onto the 
back of the DualMCU-ONE, providing 
direct access to most of the ESP32 
microcontroller's pins. It offers developers 
a practical and efficient solution to fully 
leverage the system's potential. 

The addition of the FPC connector is ideal 
for projects requiring additional external 
connections or the development of custom 
modules, such as displays, sensors, or 
port expanders. This versatility enables a  
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wide range of applications, from advanced 
prototypes to final solutions, without 
compromising the compact and functional 
design of the DualMCU-ONE board. 

Robust Power Supply: 

The DualMCU-ONE board features a 
robust power supply based on the 
MP1482DS integrated circuit. Unlike the 
traditional Arduino UNO, the 
DualMCU-ONE can support a maximum 
input voltage of 18V, thanks to this 
advanced regulator. The MP1482DS 
ensures efficient power conversion, 
delivering greater power and higher 
current output at 5V. This enhancement 
provides more stability and flexibility for 
demanding projects, allowing the 
DualMCU-ONE to power more peripherals 
and complex circuits without 
compromising performance. 

CAN Bus Connectivity: 

The DualMCU-ONE board includes CAN 
bus connectivity through the ESP32 
microcontroller, which is equipped with a 
TCAN1051HVD transceiver. This setup 
allows for direct connection to a CAN bus, 
with CAN HIGH, CAN LOW, and GND 
available on the female headers. The 
TCAN1051HVD is a high-speed CAN 
transceiver that operates at data rates up 
to 1 Mbps and is suitable for working with 
a 3.3V I/O voltage range, ensuring 
compatibility with the ESP32. This 
integration provides reliable and efficient 
communication in automotive and 
industrial environments, making the 
DualMCU-ONE a powerful tool for 
applications requiring robust CAN bus 
connectivity. For more details, refer to 
Sections 3.6 and 4.5. 

 

Support: 

In addition to support for the Arduino IDE, 
the DualMCU-ONE board is compatible 
with the Raspberry Pi C/C++ SDK, 
specifically for C development on the 
RP2040 microcontroller. For Python-based 
projects, integrated development 
environments (IDEs) such as Thonny can 
be used, enabling work with MicroPython 
and CircuitPython on both 
microcontrollers, the RP2040 and the 
ESP32. 

Additionally, for the ESP32, the 
DualMCU-ONE is compatible with 
advanced tools like Espressif IDE, 
expanding development options with 
dedicated support for the Espressif 
ecosystem. This flexibility makes the 
DualMCU-ONE a robust and versatile 
solution, ideal for developers looking to 
fully leverage the combined capabilities of 
both microcontrollers on a single 
development board. 
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Applications of the DualMCU-ONE 

The DualMCU-ONE has been designed 
with both beginners and advanced users 
in mind, offering a versatile and powerful 
experience that adapts to any skill level. 

Arduino Uno Compatibility 

If you are just starting to explore 
electronics or already have experience 
working with Arduino Uno, the 
DualMCU-ONE is the perfect choice for 
you. Its pin distribution on the female 
headers is fully compatible with that of 
Arduino Uno, ensuring that you can use 
most shields designed for that platform 
without making significant changes to your 
existing code.​
This means you can easily replace your 
Arduino Uno board with the 
DualMCU-ONE and enjoy its extensive 
compatibility, while keeping in mind that 
the DualMCU-ONE operates with 3.3V 
logic levels instead of Arduino Uno’s 
typical 5V. 

Greater Power and Possibilities 

By integrating the RP2040 microcontroller 
instead of the ATmega328P, the 
DualMCU-ONE significantly expands the 
capabilities of your projects: 

●​ 32-bit Processor: Dual-core ARM 
Cortex-M0+ with a clock speed of 
up to 133 MHz. 

●​ DMA and PIO (Programmable 
I/O): Offload tasks from the 
processor for more efficient 
performance. 

●​ Interconnection with ESP32: 
Another 32-bit microcontroller 
connected via SPI, adding Wi-Fi  

 

and Bluetooth wireless 
capabilities and functioning as a 
co-processor. 

For Beginners and Experts 

●​ Beginners: You can use the 
DualMCU-ONE as easily as an 
Arduino Uno board. All your 
Arduino code will work seamlessly, 
removing any technical barriers. 

●​ Advanced Users: The board 
offers incredible potential thanks to 
its advanced features, such as four 
programmable cores, wireless 
communication, CANBUS support, 
and low power consumption, 
enabling more complex and 
ambitious projects. 

Application Areas 

The DualMCU-ONE is perfect for a wide 
range of applications: 

●​ Education: Ideal for students and 
makers who want to learn about 
advanced microcontrollers while 
maintaining the simplicity of the 
Arduino environment. 

●​ Internet of Things (IoT): Its 
built-in wireless capabilities make it 
an excellent choice for developing 
connected devices. 

●​ Prototyping: Its features allow for 
rapid and efficient prototyping with 
a compact and versatile design. 

●​ Machine Learning: Its processing 
power supports exploring basic 
machine learning models and 
advanced tasks. 
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●​ Robotics: With multiple pins and 
advanced processing capabilities, 
it is ideal for robotics projects  

requiring motor control, sensors, 
and advanced communications. 

●​ Advanced Projects: Its 
compatibility with Arduino Uno 
shields and additional features 
make it a powerful tool for 
designing final solutions. 

With the DualMCU-ONE, both beginners 
and experts can unlock the full potential of 
working with two advanced 
microcontrollers on a single board, taking 
their projects to the next level. 
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Features 
 

Raspberry Pi RP2040 Microcontroller  
●​ 133MHz 32bit Dual Core Arm® 

Cortex®-M0+  
●​ 264kB on-chip SRAM  
●​ Direct Memory Access (DMA) 

controller  
●​ Support for up to 16MB of off-chip 

Flash memory via dedicated QSPI 
bus 

●​ Programmable IO (PIO) for extended 
peripheral support  

●​ 30 GPIO pins, 4 of which can be used 
as analog inputs 

●​ 4 channel ADC with internal 
temperature sensor, 0.5 MSa/s, 12-bit 
conversion  

●​ 16 PWM channels 
●​ SWD Debugging  
●​ 2 UARTs 
●​ 2 SPI controllers 
●​ 2 I2C controllers 
●​ 8 PIO state machines  
●​ USB 1.1 controller and PHY, with host 

and device support  
●​ 2 on-chip PLLs to generate USB and 

core clock  
●​ 40nm process node  
●​ Multiple low power mode support  
●​ Internal Voltage Regulator to supply 

the core voltage  
●​ Advanced High-performance Bus 

(AHB)/Advanced Peripheral Bus 
(APB)  

 
Memory  
●​ W25Q16JVUXIQ 2MB NOR Flash  
●​ 532MHz Quad SPI 
●​ 66MB/S continuous data transfer rate  
●​ 100K program/erase cycles 
●​ More than 20-year data retention 
 
 

 
 
 
Espressif ESP32 WROOM 32  
Wi-Fi/Bluetooth® Module 
●​ 240MHz 32bit Dual Core Xtensa LX6  
●​ 520kB on-chip SRAM  
●​ 448 Kbyte ROM for booting and core 

functions  
●​ 8 MB Integrated SPI flash  
●​ 1 kbit EFUSE (non- erasable memory) 

for MAC addresses, module 
configuration, Flash-Encryption, and 
Chip-ID  

●​ IEEE 802.11b/g/n (802.11n up to 150 
Mbps) single-band 2.4 GHz Wi-Fi 
operation, center frequency range of 
operating channel (2412 ~ 2484 MHz) 

●​ Bluetooth® 4.2 BR/EDR and 
Bluetooth LE specification, NZIF 
receiver with –97 dBm sensitivity, 
Class-1, class-2 and class-3 
transmitter, AFH 

●​ +12 dBm transmitting power, the 
internal PCB antenna in the module 
eliminates the need for an external 
antenna 

●​ ADC, I2C, SDIO, QSPI, UART, I2S, 
Two-Wire Automotive Interface 
(TWAI®), compatible with ISO11898-1 
(CAN Specification 2.0)  

●​ On-chip Hall Sensor 
 
WS2812B-3030 LED   
●​ RGB NeoPixel for full color indication 
●​ Connected to RP2040 GPIO (24) 
 
RGB-2020 LED  
●​ Common Anode  
●​ Connected to ESP32 GPIO (25, 26, 

27 ) 
 
Builtin LED 
●​ LED for general purpose blinking, 

connected to RP2040 GPIO25 
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MicroSD CARD 
●​ Connected to ESP32 vía QSPI 

GPIO(2,4,12,13,14,15) 
 
I/O  
 
●​ From the RP2040: 13 digital pins and 

4 analog pins (compatible with the 
Arduino UNO pinout), plus additional 
pins from the ESP32 MCU.  

●​ 3 x UART peripherals (2 UARTs in the 
RP2040 and 1 in the ESP32) 

●​ 3 x SPI (two from RP2040 and one in 
the ESP32) 

●​ 3 x  I2C (Two of which have a JST-1.0 
mm pitch on-board connectors, 
compatible with STEMMA QT and 
QWIIC devices) 

●​ All digital pins of RP2040  can be 
driven by the PWM block  

●​ All ESP32 pins digital outputs can be 
used as PWM pins (GPIOs 36 and 39 
can't generate PWM) 

●​ ESP32 CAN 2.0 
 
Power  
●​ Vin max 20 V over Jack connector 

(J2) for power supply 
●​ 5V out max 2A efficient conversion 

(MP1482DS ) 
●​ 3.3 v LDO 800 mA 
 
CAN BUS connectivity 
●​ TCAN1051HVD high-speed CAN 

transceiver that operates at data rates 
up to 1 Mbps working at 3.3V I/O 
voltage range. Connected to GPIO25 
y GPIO26 in the ESP32.  

 
Connectors 
●​ 2 x I2C JST-SH (1 mm pitch) (QWIIC 

standard connector, one for ESP32 
microcontroller and the other one for 
the RP2040 microcontroller) 

 
●​ 1 x UART JST-SH (1 mm pitch) for 

ESP32-UART2 
●​ 1 Auxiliary microSD Card Holder 
●​ 1 Auxiliary  FPC-24P  
●​ 1 USB Type C 
●​ 2 x USB JST-SH (1 mm pitch). Direct 

connection of usb devices to the USB 
hub. 

●​ 1 Optional JST-SH 3P (1 mm pitch) 
for RP2040 debugging 

●​ 1 Jack connector for power supply 
(J2) 

Communication and Connectivity 

●​ USB Type-C hub (HS8836A) 
●​ DIP Switch for UART communication 
●​ Reset button and Bootloader select 

button for RP2040 quick restarts (no 
unplugging-replugging to relaunch 
code) 

●​ ESP32 Reset button and Flash/Boot 
button for manually entering flash 
mode 

●​ ESP32 2x3 pin header for SPI output 
●​ ESP32 2x3 pin header for GPIO 

output  and programming (IO0, I04, 
TX0, RX0, RST, GND) 

●​ RP2040 2x3 pin header for SPI output 
●​ CANH, CANL and GND out available 

in the female header for direct CAN 
Bus connectivity and 120 ohm link 
resistor for bus impedance 

 
OSC 
●​ 12 MHz crystal for perfect timing for 

RP2040 microcontroller 
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1 The Board  
 
1.1 Accessories  
 
USB type C cable  
1x6-pin 2.54mm female headers  
1x8-pin 2.54mm female headers  
2x10-pin 2.54mm female headers  
3x(2x3)  2.54mm male headers  
 
2 Ratings  
 
2.1 Recommended Operating Conditions 
 

Symbol Description Min Typ Max Unit 

VIN Input voltage from VIN pin 7 12   20  V 

V5v Output System Voltage (Vsys) 4.6 5 5.5 V 

I5v 5V output current (MP1482DS)◆  1.5 1.8 2 A 

V3v3 3.3V output to user application 3.25 3.3 3.35 V 

I3v3 3v3 output current (including onboard IC) 600 800 1000 mA 

VIH 
(RP2040) 

Input high-level voltage  2 - 3.6 V 

VIL 
(RP2040) 

Input low-level voltage  -0.3 - 0.8 V 

IOH Max 
(RP2040) 

Current at VDD-0.4v, output set high    8 mA 

IOL Max 
(RP2040) 

Current at VSS+0.4v, output set low    8 mA 

VOH 
(RP2040) 

Output high voltage, 8 mA  2.62 - 3.3 v 

VOL 
(RP2040) 

Output low voltage. 8 mA 0 - 0.5 V 

 RPU 
(RP2040) 

Pull-Up Resistance 50 - 80 kΩ 

RPD 
(RP2040) 

Pull-Down Resistance 50 - 80 kΩ 

IIOVDD_MAX Maximum Total IOVDD current*   50 mA 
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(RP2040) 

IIOVSS_MAX 
(RP2040) 

Maximum Total VSS current due to IO 
(IOVSS)** 

  50 mA 

TOP 
(RP2040) 

Operating temperature -20 - 80 °C 

VIH 
(ESP32) 

Input high-level voltage  2.475 - 3.6 V 

VIL 
(ESP32) 

Input low-level voltage  -0.3 - 0.825 V 

IOH Max 
(ESP32) 

Current at VDD=3.3V, VOH >=2.64V, 
output set high*** 

  40 mA 

IOL Max 
(ESP32) 

Current at VDD = 3.3 V, VOL =0.495 V, 
output set low 

  28 mA 

VOH 
(ESP32) 

Output high voltage 2.64 - 3.3 V 

VOL 
(ESP32) 

Output low voltage - - 0.33 V 

 RPU 
(ESP32) 

Pull-Up Resistance - 45 - kΩ 

RPD 
(ESP32) 

Pull-Down Resistance - 45 - kΩ 

TOP 
(ESP32) 

Operating temperature -40 - 85 °C 

 
* Sum of all current being sourced by GPIO and QSPI pins  
**Sum of all current being sunk into GPIO and QSPI pins 
***Per-pin current sourced in the same domain is gradually reduced from around 40 mA to around 29 mA, 
VOH>=2.64 V, as the number of current-source pins increases 
◆ When operating at 2A, the MP1482DS requires the implementation of heat dissipation or proper cooling to 
ensure safe operation. 
- If the component temperature reaches 150°C, thermal protection will activate, halting operation to prevent 
damage. 
- To maintain optimal performance, it is recommended to add a heatsink or enhance airflow. 
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3 Functional Overview  

The UNIT DualMCU-ONE is a cutting-edge development board that combines the ESP32 
and RP2040 microcontrollers, offering unparalleled versatility for electronics projects. This 
board is designed to deliver robust connectivity, seamless integration, and compatibility with 
the Arduino UNO shield ecosystem. 

Key features include a USB Type-C hub for simultaneous MCU connections, integrated CAN 
bus connectivity for industrial applications, and enhanced communication protocols like 
UART and SPI for efficient MCU intercommunication. The board also supports popular 
programming environments, such as Arduino IDE, MicroPython, CircuitPython, and the 
Raspberry Pi C/C++ SDK, ensuring flexibility for developers of all levels. 

Designed with precision, the DualMCU-ONE enables direct access to essential features like 
I2C connectors, WS2812B and RGB LEDs for visual feedback, and optional expandable 
connectivity through an FPC-24P connector. A robust power management system allows for 
reliable operation across demanding applications, and its support for Micro SD storage 
ensures efficient data handling. 

With its combination of advanced features, intuitive design, and compatibility with Arduino 
UNO shields, the UNIT DualMCU-ONE is the ideal solution for educational, IoT, prototyping, 
robotics, and machine learning projects, catering to both beginners and experts alike. 

3.1 Block Diagram 

 
Block Diagram of DualMCU-ONE RP2040 + ESP32 
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3.2 Board Topology 
 
Front View 
 

 
 

Front View of DualMCU-ONE RP2040 + ESP32 Topology 
 

Table 3.2.1 - Components Overview: Front View 

Ref. Description Ref. Description 

U1 Raspberry pi RP2040 Microcontroller U4 CH340C USB bus convert IC 

U2 Espressif ESP32 WROOM Wi-Fi/Bluetooth® 
Module 

U5 HUB USB IC 

U3 W25Q16JVUXIQ 2MB Flash IC U6 NCP1117ST33T3G 3v3 LDO Voltage Regulator 

U7 MP1482DS-LF-Z DC/DC Converter U8 TCAN1051HVD CAN BUS Transceiver 

L1 Power On LED L2 Builtin LED 

L3 TX LED L4 RX LED 
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L5 RGB-2020 LED L6 WS2812B-3030 LED 

J1 Male USB Type C Connector J2 Power Jack Connector 

PB1 RP2040 Reset Button PB2 RP2040 Boot Button 

PB3 ESP32 Flash Button PB4 ESP32 Reset Button 

JP1 ESP32 SYSTEM AND UART Header JP2 ESP32 SPI Header 

JP3 RP2040 SPI Header JP4 JP4-1,JP4-2,JP4-3,JP4-4: Female Headers 
2.54mm, compatible with Arduino UNO Pinout 

JST1 ESP32 UART JST Connector JST2 ESP32 I2C-QWIIC JST Connector 

JST3 AUX USB COMX JST Connector JST4 AUX USB COMY JST Connector 

JST5 RP2040 JST-3P Debugging Connector JST6 RP2040 I2C-QWIIC JST Connector 

SW1 UART DIP Switch   

 
 
Back view 

Back View of DualMCU-ONE RP2040 + ESP32 Topology 
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Table 3.2.2 - Components Overview: Back View 

Ref. Description Ref. Description 

X1 Auxiliary MicroSD Card Connector X2 Auxiliary FPC-24P Connector 

SB1 RP2040 to ESP32_RST Solder Bridge 
(disconnected) 

SB2 120R CAN BUS Resistor Solder Bridge 
(disconnected) 

SB3 Steps ADC3 Leakage Solder Bridge 
(disconnected) 

SB4 ESP32-IO14 to  RP2040-GPIO15 Solder 
Bridge (Connected) 

TP1 USB D- Test point  
 

TP2 USB D+ Test point  

 
3.3 Processor 

The DualMCU-ONE is powered by the Raspberry Pi RP2040 microcontroller (U1), 
manufactured using a modern 40nm process. This is Raspberry Pi's debut microcontroller, 
known for its high performance and ease of use in embedded systems.​
Key features include: 

●​ Memory: Six independent banks of 264 KB SRAM, totaling a large on-chip memory. 
●​ CPU: Dual symmetric Arm® Cortex®-M0+ processors clocked at 133 MHz. 
●​ Bus Fabric: Deterministic bus fabric ensuring reliable performance. 
●​ Peripherals: A rich peripheral set augmented by a unique Programmable I/O (PIO) 

subsystem. 
●​ Debugging: Serial Wire Debug (SWD) support, accessible via the JST5-3P 

connector. 
●​ USB Interface: USB 1.1 device interface for uploading code. 
●​ External Flash: 2 MB off-chip Flash memory accessible via a dedicated QSPI bus. 

The RP2040 also manages the digital pins and analog pins (A0–A3), as well as the I2C 
connections (SDA and SCL) on the JST6 QWIIC connector.  

3.4 Wi-Fi/Bluetooth® Connectivity Module 

The DualMCU-ONE integrates an Espressif ESP32 WROOM-32 (U2) module for Wi-Fi and 
Bluetooth® connectivity, with the CH340C (U4) USB-to-UART bridge IC enabling 
programming and communication via USB.  

Key specifications include: 

●​ CPU: Dual-core Xtensa LX6 clocked at up to 240 MHz. 
●​ Memory: 512 KB on-chip SRAM and 8 MB SPI Flash memory. 
●​ Peripherals: 

○​ Multiple programmable GPIOs. 
○​ ADC, I2C, UART, and Capacitive Touch Sensor. 
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○​ Two-Wire Automotive Interface (TWAI®), compliant with ISO11898-1 (CAN 
Specification 2.0). 

●​ Pin connectors: Interfaces are exposed through the JP1,and JP2 pin headers, as 
well as the auxiliary FPC-P24 connector (X2). 

3.5 External Memory 
 
The RP2040 (U1) accesses external 2 MB Flash memory (U3) via a QSPI interface. This 
external memory stores application code and data, utilizing execute-in-place (XIP) 
technology to run code directly from Flash without requiring RAM transfer. 
 
3.6 CAN BUS 

The TCAN1051HVD IC (U8) serves as the CAN transceiver, enabling the ESP32 
microcontroller to interface with the CAN bus, which is widely used in automotive and 
industrial applications for robust and efficient communication. The TCAN1051HVD is a 
high-speed CAN transceiver capable of operating at data rates up to 1 Mbps, providing 
reliable transmission of data in environments with high electromagnetic interference (EMI). 

This IC is designed to handle the standard 3.3V logic levels of the ESP32 and ensures 
seamless integration with the CAN bus, which is essential for applications such as vehicle 
diagnostics, industrial control systems, and robotics. The transceiver supports both CAN 
High and CAN Low lines, as well as the Ground connection, making it a complete solution 
for communication on the CAN bus. 

By utilizing this transceiver, the DualMCU-ONE board offers exceptional flexibility for 
developers working on automotive, industrial, or IoT applications that require reliable and 
efficient communication. For detailed information about the pin connections for CAN bus 
communication, refer to Table 4.5.4. 

3.7 RGB LED 

 

The common anode RGB-2020 LED (L5) 
is controlled by the ESP32 module. It 
lights up when the digital state is LOW and 
turns off when the state is HIGH. The 
ESP32 GPIOs connected to the LED are 
IO25, IO26, and IO27. 
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3.8 WS2812B LED 

 

The WS2812B-3030 LED (L6) is an 
intelligent RGB NeoPixel designed for 
full-color indications. It is connected to the 
RP2040 via: 

●​ GPIO24 for the digital input (DI). 
●​ D28 when using in the Arduino 

environment. 

 

 
3.9 MicroSD Card Socket 

 

The ESP32 interfaces with a microSD 
card via the onboard socket (X1), utilizing 
a QSPI interface. This functionality is ideal 
for applications requiring large file storage 
beyond the ESP32's SPIFF (flash file 
system). The MicroSD card socket 
supports high-capacity memory cards up 
to 64 GB (tested), enabling efficient data 
storage for advanced applications such as 
data logging or multimedia handling. 

Note: The MicroSD card socket (model 
THD2528-11SD-GF) is an auxiliary 
component that must be purchased 
separately. It can be soldered onto the 
designated pads on the bottom side of the 
DualMCU-ONE board.  

For further details on connection mapping, 
refer to Table 4.6.1. 
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3.10 MP1482DS: Robust DC/DC Converter for Power Supply Management 

The MP1482DS-LF-Z (U7) integrated circuit provides a robust and efficient DC/DC 
conversion system for powering various components on the board. Unlike traditional Arduino 
UNO boards, the DualMCU-ONE can accept input voltages of up to 18-20V, offering greater 
flexibility in power supply options. 

This high-performance regulator ensures stable 5V output and supports higher current 
demands (2A), enabling the board to power multiple peripherals and complex circuits without 
compromising performance. The MP1482DS provides enhanced power management, 
making the board ideal for demanding projects requiring robust and reliable power delivery. 

3.11  USB HUB for the USB Communication  

The USB HUB (HS8836A) (U5) replaces the traditional USB communication switch found in 
the original DUALMCU board. This advanced hub allows simultaneous connections to both 
the RP2040 and ESP32 microcontrollers through a single USB Type-C connector, 
significantly simplifying the development process. 

Additionally, the USB HUB supports two external USB devices via JST connectors with a 1 
mm pitch. This feature expands the board's connectivity options, making it versatile for 
advanced setups involving additional USB peripherals, such as external storage or input 
devices. 
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3.12 DIP Switch for UART Communication 

The DualMCU-ONE includes a DIP switch (SW1) to facilitate UART communication between 
the two onboard microcontrollers.  

 

This switch enables the following pin connections: 

Table 3.12.1 - UART Pin Mapping via DIP Switch 

Microcontroller UART Pin DIP Switch Connection Function 

RP2040 Tx (GPIO0) Connected to Rx (IO16) on ESP32 Transmit Data from RP2040 to ESP32 

RP2040 Rx (GPIO1) Connected to Tx (IO17) on ESP32 Receive Data from ESP32 to RP2040 

ESP32 Tx (IO17) Connected to Rx (GPIO1) on RP2040 Transmit Data from ESP32 to RP2040 

ESP32 Rx (IO16) Connected to Tx (GPIO0) on RP2040 Receive Data from RP2040 to ESP32 

By toggling the DIP switch, developers can establish direct UART communication for data 
transfer and control between the microcontrollers. This setup is especially useful when the 
ESP32 functions as a co-processor, managing wireless connectivity or CAN BUS 
communication, while the RP2040 handles other operational tasks.  For further details on the 
location of SW1, refer to Table 3.2.1 - Components Overview: Front View. 
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3.13 SPI Communication Between MCUs (RP2040 and ESP32) 

The SPI communication interface between the RP2040 and the ESP32 microcontrollers 
allows for high-speed data transfer and enhanced reliability in system operations. This 
communication is crucial for enabling seamless data exchange between the two 
microcontrollers, ensuring efficient performance in applications requiring concurrent 
processing by both chips. 

Additionally, the ESP32 is fully compatible with the Arduino NINA firmware, which 
facilitates the integration of Wi-Fi and Bluetooth capabilities. The NINA firmware, designed 
for the u-blox NINA-W102 module (based on ESP32), provides an easy-to-use API for 
wireless communication, enabling reliable and robust wireless connectivity in IoT and other 
communication-focused applications. By leveraging the NINA firmware, you can also extend 
the ESP32's functionality to manage other system components, such as CAN bus 
communication, PWM signals, and additional ADC channels beyond what the RP2040 
offers. This setup allows the RP2040 to control the ESP32 as an effective co-processor, 
offloading specific tasks like wireless communication or managing additional peripherals 
while the RP2040 handles other critical operations. 

For detailed information on the pin mappings and connections for SPI communication, refer 
to Table 3.13.1. 

 
Table 3.13.1: SPI Pin Mapping for RP2040 and ESP32 Communication 
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RP2040 
(Master) 

Function ESP32 
(Slave) 

Function Arduino UNO 
Matching1 

GPIO12 MISO IO23 MOSI D24 

GPIO13 CS0 IO5 CS0 D25 

GPIO14 SCK IO18 SCK D26 

GPIO15 MOSI IO14 MISO D27 

GPIO7 BUSY IO33 BUSY D23 
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3.14 Power Tree 

The DualMCU-ONE supports dual power input options: it can be powered either through the 
USB-C port (J1) or via the VIN pin on J2, which accepts a voltage range of 18–20 V 
(maximum). 

Power supply selection is managed by the LMV321 operational amplifier, ensuring seamless 
switching between sources. If a voltage is present on the VIN pin, it takes priority; otherwise, 
power is drawn from the USB-C connector. 

The VIN input is regulated by the MP1482DS DC/DC converter, which steps down the 
voltage to provide a stable 5V output at up to 2A of current. A secondary LDO regulator, the 
NCP117ST33, further converts the 5V supply to 3.3V, delivering up to 800 mA. 

This 3.3V rail powers the RP2040 and ESP32 microcontrollers, as well as all other onboard 
peripherals, ensuring stable and efficient operation throughout the system. 

 

 
 DualMCU-ONE RP2040 & ESP32 Power Tree 
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4 Connectors & Pinouts  
 
4.1 General Top Side Pinout 
 

 
 
 

DualMCU-ONE  RP2040&ESP32 General TOP Side Pinout 
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4.2 General Bottom Side Pinout 

 
DualMCU-ONE  RP2040&ESP32 General BOTTOM Side Pinout 
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4.3 DualMCU-ONE: Arduino UNO Pinout Compatibility 
 

 
Arduino UNO-Compatible Pinout on DualMCU-ONE 
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Table 4.3.1 - Pin Mapping and Connections for the Arduino UNO-Compatible Pinout (Connections to the RP2040 MCU) 
 

Arduino UNO 
Function 

DualMCU-ONE 
(RP2040) RP2040 MCU Function 

- GND GND GND 

- CANL - CAN BUS - LOW 

- CANH - CAN BUS - HIGH 

IOREF IOREF +5V/VSYS +5V/VSYS 

RESET RESET RUN RESET/ENABLE 

3V3 3V3 +3v3 +3v3 

5V 5V +5V/VSYS +5V/VSYS 

GND GND GND GND 

GND GND GND GND 

VIN VIN - EXTERNAL POWER SUPPLY 

A0/D14 A0/D14 GPIO26 ADC0/SPI1 SCK/ UART1 CTS/ I2C1 SDA/ PWM5 A/ SIO/ 
PIO0/ PIO1/ USB VBUS EN 

A1/D15 A1/D15 GPIO27 ADC1/SPI1 TX/ UART1 RTS/ I2C1 SCL/ PWM5 B/ SIO/ PIO0/ 
PIO1/ USB OVCUR DET 

A2/D16 A2/D16 GPIO28 ADC2/SPI1 RX/UART0 TX/ I2C0 SDA/ PWM6 A/SIO/ PIO0/ 
PIO1/ USB VBUS DET 

A3/D17 A3/D17 GPIO29 ADC3/SPI1 CSn/ UART0 RX/ I2C0 SCL/ PWM6 B/ SIO/ PIO0/ 
PIO1/ USB VBUS EN 

A4/SDA - - - 
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A5/SCL - - - 

D0/RX D0/RX0 GPIO1/RX0 SPI0 CSn/ UART0 RX/ I2C0 SCL/ PWM0 B/SIO/ PIO0/ PIO1/ 
USB VBUS DET 

D1/TX D1/TX0 GPIO0/TX0 SPI0 RX/ UART0 TX/ I2C0 SDA/ PWM0 A/ SIO/ PIO0/ PIO1/ 
USB OVCUR DET 

D2 D2/RX1 GPIO5/RX1/SCL0 SPI0 CSn/ UART1 RX/ I2C0 SCL/ PWM2 B/ SIO/ PIO0/ PIO1/ 
USB VBUS EN 

D3 D3/TX1 GPIO4/TX1/SDA0 SPI0 RX/ UART1 TX/ I2C0 SDA/ PWM2 A/ SIO/ PIO0/ PIO1/ 
USB VBUS DET 

D4 D4 GPIO9/CS1/RX1 SPI1 CSn/ UART1 RX/ I2C0 SCL/ PWM4 B/ SIO/ PIO0/ PIO1/ 
USB OVCUR DET 

D5 D5 GPIO11/MOSI1 SPI1 TX/ UART1 RTS/ I2C1 SCL/ PWM5 B/ SIO/ PIO0/ PIO1/ 
USB VBUS EN 

D6 D6 GPIO8/MISO1 SPI1 RX/ UART1 TX/ I2C0 SDA/ PWM4 A/ SIO/ PIO0/ PIO1/ 
USB VBUS EN 

D7 D7 GPIO10/SCK1 SPI1 SCK/ UART1 CTS/ I2C1 SDA/ PWM5 A/ SIO/ PIO0/ 
PIO1/ USB VBUS DET 

D8 D8 GPIO2/SDA1 SPI0 SCK/ UART0 CTS/ I2C1 SDA/ PWM1 A/ SIO/ PIO0/ 
PIO1/ USB VBUS EN 

D9 D9 GPIO3/SCL1 SPI0 TX/ UART0 RTS/ I2C1 SCL/ PWM1 B/ SIO/ PIO0/ PIO1/ 
USB OVCUR DET 

D10 D10 GPIO17/CS0 SPI0 CSn/ UART0 RX/I2C0 SCL/ PWM0 B/ SIO/ PIO0/ PIO1/ 
USB VBUS EN 

D11 D11 GPIO19/MOSI0 SPI0 TX/ UART0 RTS/ I2C1 SCL/ PWM1 B/ SIO/ PIO0/ PIO1/ 
USB VBUS DET 

D12 D12 GPIO16/MISO0 SPI0 RX/ UART0 TX/ I2C0 SDA/ PWM0 A/ SIO/ PIO0/ PIO1/ 
USB VBUS DET 
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D13 D13 GPIO18/SCK0 SPI0 SCK/ UART0 CTS/ I2C1 SDA/ PWM1 A/ SIO/ PIO0/ 
PIO1/ USB OVCUR DET 

GND GND GND GND 

AREF AREF ADC_VREF ADC_VREF 

D18/SDA D18/SDA_1 GPIO22/SDA0 SPI0 SCK, UART1 CTS, I2C1 SDA, PWM3 A, SIO, PIO0, 
PIO1, CLOCK GPIN1, USB VBUS DET 

D19/SCL D19/SCL_1 GPIO23/SCL0 SPI0 TX, UART1 RTS, I2C1 SCL, PWM3 B, SIO, PIO0, PIO1, 
CLOCK GPOUT1, USB VBUS EN 

- D20/SDA_0 GPIO20/SDA0 SPI0 RX/ UART1 TX/ I2C0 SDA/ PWM2 A/ SIO/ PIO0/ PIO1/ 
CLOCK GPIN0/ USB VBUS EN 

- D21/SCL_0 GPIO21/SCL0 SPI0 CSn/ UART1 RX/ I2C0 SCL/ PWM2 B/ SIO/ PIO0/ PIO1/ 
CLOCK GPOUT0/ USB OVCUR DET 

- D22/ESP_RESET* GPIO6 SPI0 SCK, UART1 CTS, I2C1 SDA, PWM3 A, SIO, PIO0, 
PIO1, USB OVCUR DET 

- D23/ESP_BUSY GPIO7 GPIO 

- D24/ESP_MOSI GPIO12 SPI1 RX 

- D25/ESP_SS GPIO13 SPI1 CSn 

- D26/ESP_SCK GPIO14 SPI1 SCK 

- D27/ESP_MISO GPIO15 SPI1 TX 

- D28/NEOP GPIO24 Only connected to WS2812B-3030 LED 

- D29/LED_BUILTIN GPIO25 Only connected to LED_BUILTIN 
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●​ D22 (GPIO6) is by default disconnected from ESP_RESET; to connect them, you 
need to solder the pad located on the back of the board. 

 

●​ D22, D23, D24, D25, D26, and D27 are directly connected to the ESP32 
microcontroller and are used for SPI communication between the two 
microcontrollers. It is important to note that D23 and D27 are only accessible through 
the FPC-24 connector. 

●​ D28 and D29 are not available on any connector or header; their control is 
exclusively limited to the RP2040 microcontroller, They are only connected to the 
WS2812B-3030 LED and the  Built-in LED. 
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4.4 RP2040 Debugging, QWIIC, and SPI Connectors 
 

DualMCU-ONE RP2040 Debugging, QWIIC, and SPI Connectors 
 
 
 
 
 
 
 
 
 
 
 
 

30 ​ ​ ​ Unit Electronics ® DualMCU-ONE RP2040+ESP32​ ​   Modified: 12/01/2025 
  



 

 DualMCU-ONE  
         RP2040 + ESP32 

SKU: UE00022 
 

 
Table 4.4.1 - RP2040 SPI Header Connector 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Table 4.4.2 - RP2040 Debugging Connector 
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Pin RP2040 Function Arduino UNO Matching 

1 GND GND - 

2 GPIO17 CSn D10 

3 GPIO19 MOSI D11 

4 GPIO18 SCLK D13 

5 +3V3 +3V3 - 

6 GPIO16 MISO D12 

Pin RP2040 (UART0) Function 

1 SWDIO SWDIO 

2 GND GND 

3 SWCLK SWCLK 
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Table 4.4.3 - RP2040 I2C-QWIIC Connector 
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Pin RP2040- JST (QWIIC) Function 

1 GND GND 

2 +3V3 +3V3 

3 GPIO4 SDA 

4 GPIO5 SCL 
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4.5 ESP32: SPI & UART Headers, I2C-QWIIC, JST-UART and CAN BUS  Connectors 
 

 
DualMCU-ONE - ESP32 MCU Connectors 

 
Table 4.5.1 ESP32: SYSTEM & UART Header 
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Pin ESP32 Function 

1 EN RST/ESP_RESET 

2 GND GND 

3 IO3 TX0 

4 IO4 4 

5 IO1 RX0 

6 IO0 DTR/0 
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Table 4.5.2 ESP32: SPI Header 

Pin ESP32(Master) Function Connection to the RP2040 MCU Arduino UNO Matching1 

6 GND GND GND - 

5 IO23 MOSI GPIO12 D24 

4 IO18 SCK GPIO14 D26 

3 IO19 MISO - - 

2 IO5 SS GPIO13 D25 

1 +3V3 +3V3 +3V3 - 

Notes: 

1 The declaration of the definitions D23, D24, D25, D26, and D27 in Arduino is only useful when selecting the RP2040 microcontroller in the Arduino IDE 
(Board: UNIT Dual ONE RP2040). 

 

Table 4.5.3 ESP32: I2C-QWIIC & JST-UART 

Pin ESP32 - JST (QWIIC) Function ESP32 - JST (UART2) Function 

1 GND GND GND GND 

2 +3v3 +3v3 +3v3 +3v3 

3 IO21 SDA IO16 RX1 

4 IO22 SCL IO17 TX2 
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Table 4.5.4 ESP32: CAN BUS 

 
 
 
 
 
 
 
 

 
4.6 ESP32: Auxiliary MicroSD & FPC-24P  Connectors 
 

 
DualMCU-ONE: ESP32 Auxiliary MicroSD & FPC-24P Connectors 
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ESP32 (CAN) Function 

IO25 CAN_TX 

IO26 CAN_RX 
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Table 4.6.1 ESP32: MicroSD Holder2 

 

This socket is directly connected to the ESP32 microcontroller via QSPI communication, 
offering data transfer speeds up to four times faster than its predecessor, the DualMCU 
board.  

 

 

 
MicroSD Pinout 
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ESP32 (GPIO) MicroSD Pin MicroSD Function Connection to the RP2040 MCU Arduino UNO Matching1 

IO2 7 DAT0 - - 

IO4 8 DAT1 - - 

IO12 1 DAT2 - - 

IO13 2 CD/DAT3 - - 

IO15 3 CMD - - 

IO14 5 CLK GPIO15 D27 

GND 6 VSS GND - 

+3V3 4 VDD +3V3 - 
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Table 4.6.2 ESP32: Auxiliary FPC-24P Connector3 

FPC-24P Pin ESP32 (GPIO) Connection to the RP2040 MCU Arduino UNO Matching1 

1 GND - - 

2 IO4 - - 

3 IO19/MISO - - 

4 IO2 - - 

5 IO15 - - 

6 IO33 GPIO7 D23 

7 IO23/MOSI GPIO12 D24 

8 IO5/Cs GPIO13 D25 

9 IO18/SCK GPIO14 D26 

10 IO13 - - 

11 IO12 - - 

12 IO14 GPIO15 D27 

13 IO27 - - 

14 IO26 - - 

15 IO25 - - 

16 IO32 - - 

17 IO35 - - 
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18 IO34 - - 

19 IO39/SENSOR_VN - - 

20 IO36/SENSOR_VP - - 

21 +3V3 - - 

22 IO0/DTR - - 

23 RST - - 

24 VSYS - - 

Notes: 

2 The MicroSD socket, model THD2528-11SD-GF, can be soldered directly onto the bottom side of the board. Please note that 
this socket is not pre-installed on the DualMCU-ONE board. However, end users can purchase the socket separately and 
solder it onto the designated pads, offering flexibility for those who wish to utilize this feature. 

3 Please note that this FPC-24P connector is not pre-installed on the DualMCU-ONE board. This connector can be soldered 
onto the back of the DualMCU-ONE, providing direct access to most of the ESP32 microcontroller's pins.  
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4.7 - Auxiliary JST Connectors (1mm Pitch) for USB 

 

 

The DualMCU-ONE board includes 1mm pitch JST connectors that provide the capability to 
connect additional USB devices via the HS8836A USB Type-C hub. These connectors allow 
for the connection of up to two additional USB-powered devices, using the JST3 and JST4 
ports. These ports support USB-powered devices such as keyboards, mice, additional 
development boards, or USB modules, thereby expanding the system’s functionality without 
the need for additional USB ports on the board. 

The JST3 and JST4 connectors are available on the PCB and are labeled as COMx for 
JST3 and COMY for JST4. Each connector follows a standard pinout, with the following pin 
assignments: 

●​ Pin 1: GND (Ground) 
●​ Pin 2: VUSB (Power) 
●​ Pin 3: D- (Data -) 
●​ Pin 4: D+ (Data +) 
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It is important to note that the power for these connectors comes directly from the VUSB pin, 
which is protected by a 1.2A fuse. Therefore, it is essential to consider the power 
consumption of the devices connected to these ports to avoid exceeding the load allowed by 
the fuse, ensuring safe and stable operation of the system. 

The following tables detail the pinout for the JST3 and JST4 connectors, along with their 
respective pin connections. 

Table 4.7.1 - JST3 (COMx) Connector Pinout 

 

 

 

 
 
 

Table 4.7.2 - JST4 (COMY) Connector Pinout 

 
 
 
 
 
 
 
 
 
For further details on the location of the JST connectors on the PCB, refer to Section 4.1, 
as well as the electrical schematic at the end of this document. The schematic provides a 
clear overview of the electrical connections on the PCB. 
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Pin Description Connection 

1 GND Ground 

2 VUSB Power 

3 D- Data - 

4 D+ Data + 

Pin Description Connection 

1 GND Ground 

2 VUSB Power 

3 D- Data - 

4 D+ Data + 
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5 Board Operation  
 
5.1 Getting Started with arduino IDE  

To configure the DualMCU-ONE in the Arduino IDE (version 2.0 or higher), follow these 
steps: 

Adding the UNIT Electronics Boards Package 

1.​ Open Preferences:​
 

○​ Go to the File menu and select Preferences (or Settings on some systems). 
2.​ Add Board Manager URLs:​

 
○​ In the Additional Board Manager URLs field, add the following links:​

 
■​ RP2040 JSON URL: 

https://raw.githubusercontent.com/UNIT-Electronics/Uelect
ronics-RP2040-Arduino-Package/main/package_Uelectronics_r
p2040_index.json 

■​ ESP32 JSON URL:  

https://raw.githubusercontent.com/UNIT-Electronics/Uelect
ronics-ESP32-Arduino-Package/main/package_Uelectronics_es
p32_index.json 

○​ Click OK to save.​
 

3. Tip: If there are multiple URLs to add, separate them with commas. 

​
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Installing the Board Packages 

Open Board Manager:​
 

○​ Navigate to Tools > Board > Board Manager. 

Search for UNIT Electronics Boards:​
 

○​ In the search bar, type UNIT Electronics RP2040 or UNIT Electronics ESP32. 

Install the Latest Version:​
 

○​ Select the latest available version of the desired package and click Install.​
 

Note: Ensure you have an active internet connection during this step.​
 

​
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Selecting the Board 

6.​ Set Your Board:​
 

○​ Go to Tools > Board, and select the UNIT Electronics RP2040 or UNIT Electronics ESP32 
category, depending on the microcontroller you want to program. Once inside the selected 
category, choose the DualMCU-ONE board. 

 

7.​ Connect the Board:​
 

○​ Use a USB Type-C cable to connect the DualMCU-ONE to your computer. Ensure the correct 
port is selected under Tools > Port. 

 

By completing these steps, you’ll be ready to start programming your DualMCU-ONE using 
Arduino IDE. 
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6 Mechanical Information  

 
Mechanical dimensions of DualMCU-ONE RP2040 + ESP32 

 
 
 
7 Company Information 
 

Company name  UNIT Electronics 

Company website https://uelectronics.com/ 

Company Address Salvador 19, Cuauhtémoc, 06000 Mexico City, CDMX 
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8 Reference Documentation 

Ref Link 

UNIT DualMCU-ONE 
Documentation 

https://github.com/UNIT-Electronics/DualMCU-ONE 

UNIT DualMCU-ONE 
RP2040 Arduino 
Package 

https://github.com/UNIT-Electronics/Uelectronics-RP2040-Arduin
o-Package 

UNIT DualMCU-ONE 
ESP32 Arduino 
Package 

https://github.com/UNIT-Electronics/Uelectronics-ESP32-Arduino
-Package 

Getting started with 
DualMCU-ONE 

https://unit-electronics.github.io/DualMCU-ONE/index.html 

Thonny IDE https://thonny.org/ 

Arduino IDE https://www.arduino.cc/en/software 

CH340 Driver http://www.wch-ic.com/downloads/CH341SER_ZIP.html 

Visual Studio Code https://code.visualstudio.com/download 

Raspberry Pi Pico 
RP2040 
Documentation 

https://www.raspberrypi.com/documentation/microcontrollers/ 

Raspberry Pi Pico 
Python SDK 

https://datasheets.raspberrypi.com/pico/raspberry-pi-pico-python-
sdk.pdf 

raspberrypi/pico-micro
python-examples 

https://github.com/raspberrypi/pico-micropython-examples 

Raspberry Pi Pico 
C/C++ SDK 

https://www.raspberrypi.com/documentation/microcontrollers/c_s
dk.html 

raspberrypi/pico-C/C+
-examples 

https://github.com/raspberrypi/pico-examples 

RP2040 Datasheet https://datasheets.raspberrypi.com/rp2040/rp2040-datasheet.pdf 

ESP32 WROOM 8MB https://www.espressif.com/sites/default/files/documentation/esp3
2-wroom-32e_esp32-wroom-32ue_datasheet_en.pdf 
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9 Appendix 
9.1 Schematic (https://github.com/UNIT-Electronics/DualMCU-ONE/blob/main/Hardware/UE0022_DualMCU-ONE_v2.4_Schematic.pdf) 
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